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Reader Installation and Wiring

A reliably functioning access control system starts with the proper mounting and wiring of the
readers and associated components. Readers must be securely mounted and all wire
connections must be securely connected and cable runs must be located away from sources of
electrical interference.

Mounting the Reader:
Use any templates provided to help neatly and securely mount each reader. Remove the
protective plastic sheet from the display window after installation has been completed.

Wiring:

All wire connections must be tight and properly insulated. 2 conductor shielded data cable must
be used for communication wire runs. Power cables must be a minimum size of 22 awg. All cable
types must comply with local building codes. Wiring must be run to avoid sources of EMI
interference such as florescent lighting fixtures or heavy machinery.

Each reader has a separate relay control module. For maximum security, locate this module
inside the secured area. The power supply enclosure for the system is a good choice for module
location.

Power :

Each reader requires a clean regulated source of 12VDC power. Make sure that the power supply
has the capacity to handle the power requirements of the reader and all other equipment
connected to it (eg. slave readers, locks) continuously. If you are powering the lock on the
same power supply as the reader, you must use a MOV across the locks’ coil leads to protect the
readers from spikes and noise.

All wire must be of the proper gauge for the length of the wire run. Excessive voltage drop will
impair the operation and reliability of the installation. Cabling must be in compliance with all
regulations and building codes.

E5P NOTE: Dual voltage power supplies
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Reader Setup

Each reader must have a separate Terminal Address

CONNECTING Front Door Side Door Rear Door
E5P READERS
TO CREATE A Terminal Terminal [#% Terminal
NETWORKED Address Address Address

SYSTEM 02 03

RS485/RS232 OR
RS485/USB
Converter

In a networked system, each reader must be assigned a unique Terminal Address Number .
The factory default terminal address number of “01”. Follow the procedure below to change the
readers Terminal Address Number at each reader. Mark the reader’s name on the reference
chart (Page iv). You will enter the location later in the reader parameter section of the sofware on
the PC.

FUNCTION PROCEDURE DISPLAY WILL SHOW
Enter Programming Press and Hold the ‘#” for | 0. CHECK VERSION
Mode 3 seconds 1. SETUP
Enter Setup Enter “1” PASSWORD:
« by g 1. ENROL 2. PASSWD
Enter Password Enter “1111” + “# 3 TIMER 4. SYSTEM
wpn 1. ALARM 2. MODE
Select System Menu Enter “4 3 COMM 4. OTHER
Select Communications Enter 3 1. ADDRESS 2. BAUD
Menu 3. FORMAT 4.RECO
Select Terminal Address Enter “1” 1. ADDRESS : 01
Menu . NEW:_
Enter New Terminal Enter “Terminal No.” + “#” | 1. ADDRESS : 02
Number (for example “02”) . NEW:_
. . g READY FOR CARD
Exit Programming Mode | Enter “# I sttt
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Master/Slave Reader Setup

Each master reader must have a separate Terminal Address

Front Door Front Door
(Entry) (Exit)

(Master Reader) (Slave Reader)

s
- *

3 I
OO

RS485 from readers

Rear Door

CONNECTING A
SLAVE READER TO
AN E5P READER

Terminal
Address

Terminal
Address
02

RS485/RS232 OR
RS485/USB
Converter

When a E5P reader is being used with slave reader (such as the SDC ESPW or another HID
compatible Wiegand reader), the ESP must be configured to operate as a Master reader. Using the
keypad on the reader, follow the procedure below to configure the ESP to operate as a Master

reader.

FUNCTION

PROCEDURE

DISPLAY WILL SHOW

Enter Programming

Press and Hold the ‘#” for

0. CHECK VERSION

Mode 3 seconds 1. SETUP
Enter Setup Enter “1” PASSWORD:

Enter Password Enter “1111” +“#” ; EI';\I/IF\I,ECI)?L i gégiévw?
Select System Menu Enter “4” ; éIE)AMRI\ZA ‘21 I\O/l'l(')I-?IIEER

Select Other Menu Enter “4” :13 g:ﬁggg 24.1.E|\_/|ZO??'\IIEE

Select More Menu Enter “4” ; SDZROE'\ég 2 4A'|:l/|-g_RPE

Select More Menu Enter “4” ; $§QEE22PE;£RD
Select Reader Menu Enter “1” :13 '\SAVA\\/[L\IP i ?_'lljDB

Select Sub Menu Enter “2” CURRENT: xxx

Press ‘1’ >Change

Set slave reader
configuration to HID

Press ‘1’ until screen
shows CURRENT: HID

CURRENT: HID
Press ‘1’ >Change

Exit Programming Mode

Press ‘#

READY FOR CARD
HEH# IR R
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Reader Terminal Address Chart

Ede da:iz; Reader Name E de da:}z; Reader Name E dedﬁz; Reader Name
01 17 33
02 18 34
03 19 35
04 20 36
05 21 37
06 22 38
07 23 39
08 24 40
09 25 41
10 26 42
11 27 43
12 28 44
13 29 45
14 30 46
15 31 a7
16 32 48
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Software Setup

Installing the Software:

Insert the installation cd provided with the ESP reader.
If setup does not begin automatically, Go to My Computer, double-click on the EntryCheck_ES5,
and double-click on Setup.exe

Log In/ Logout :

To Login
Double-click on the E5 desktop icon shortcut, or

Go to Start>All Programs>SDC>ES5>Launch E5 F
Type in the Account & Password, and click “Login” %% Account |
Default Login Credentials: Pass word: ‘
Account: a

Password: a Login I Exit
To Logout:

Press the Exit Button. ﬁ

Enter the Account & Password, and click “Log out”, or click “Exit” to cancel.

Establishing Communications with the Reader(s):

The first task is to load Reader #01 into the system and verify that proper communications
between the reader and the PC can be established. Follow the procedure documented in the
SET READER PARAMETERS section (Page 2) of the E5 Series — Software Reference Guide.

Next, test the reader to PC network communications link by synchronizing the reader’s time and
date. Follow the steps documented in the UPDATE READER TIME section (Top of Page 5) of
the Software Reference Guide. If the communications link has been established correctly, a
message window will indicate a successful result.

When you have verified the communications with Reader #01, load and test any remaining
readers into the system.

Note:

If you are having problems communicating with a reader(s), make sure that the wiring is correct
and that you have assigned each reader its own unique Terminal Address number. Also, verify
that the reader was loaded with the correct Com Port number.
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Enter Time Zone and Holiday Schedules :
Note: If the reader will be active at all times, and all the users will have 24/7 access, you may skip
this section.

Follow the procedure documented in the SET TIME ZONE PARAMETERS section (Page 3) of the
Software Reference Guide to define access schedules for each reader.

Follow the steps documented in the HOLIDAY SCHEDULE TABLE section (Page 4) of the
Software Reference Guide to define holiday schedules for each reader.

Enter Company Profile, Departments and Job Titles:
Note: These fields are optional. If you include them in each user’s profile you may use them in the
report module to sort your user and transaction data.

To add or edit Company information, follow the steps in the COMPANY PROFILE section (Page
6), the DEPARTMENT CODE MAINTENANCE section (Top of Page 7), and the JOB TITLE
MAINTENANCE (Bottom of Page 7) section.

Enter Cardholder Data :

Follow the procedure documented in the CARDHOLDER PROFILES section (Pages 8-11) of the
Software Reference Guide to add Cardholders and set their access rights.

Backup the Cardholder Database :

Once the cardholder access information has been entered & saved, follow the procedure
documented in the BACKUP DATABASE section (Page 18) of the Software Reference Guide to
make a backup copy of the database.

Time synchronization:

The ES5 reader’s clock can be synchronized to the clock of the monitoring PC by a manually or
automatically on a scheduled basis.

To manually synchronize the time, use the TIME CORRECTION TO THE READER (function 1-3)
To automatically synchronize the time, you must first enable SYNCRONIZATION FOR TIME

FROM THE SYSTEM TO THE READER in the scheduled jobs menu (function 5-6). Then start
the scheduler (function 6) and allow it to run in the background of the monitoring PC.
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Log in/Logout

Log In/ Logout :

To Login
Double-click on the E5 desktop icon shortcut, or
Go to Start>All Programs>SDC>ES5>Launch E5

Type in the Account & Password, and click “Login” | % Account
Default Login Credentials: Pass word: [
Account: a

Password: a Lagin | Exit
To Logout:

Press the Exit Button. @

Enter the Account & Password, and click “Log out”, or click “Exit” to cancel.
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SET SYSTEM PARAMETERS

U CIElx)
1. Syslern 2Users ‘ Monitor 4 Reports 5Database | 6. Sched-.ie 7.Help 8.Exit

B % ©

i1 12| 13| 14

Communication Rate | =

Data Format: I J

Language: | _|

Card Number Length: | =

Way of Export: [ _|

Automatic Execution: | =]

Set System Parameters F13PM 5/27/2008

Use this menu to set the way that the software communicates to the readers. By selecting Edit
you can change the following parameters:

Communication Rate : 9600 baud (default) or 19200 baud.
Data Format : 7 bits 1 stop bit odd parity (default) or 8 bits 1 stop bit no parity.
Language : English (default)
Way to Export : No Export (default), To a fixed file, Daily Export, Monthly Export

Automatic Execution : Disable (default) or Enable. This enables the transaction export feature .

The communication rate and the data format must match the settings of both the PC comport
settings in your PC and the Com Settings at each reader. The factory default settings of the
readers are 9600 baud with a format of 0,7,1 .

Once your changes are complete, press SaveEto exit, or Cancel
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SET READER PARAMETERS

212 = [BiX]
' s 8| €
ﬁ;& ﬁ s : ¥
1 Syt 2 Usery 3 Morsor | 4 Regorts EDa'm:e; B Schedule | T Help BEst |
2 K| % =
1-1 'I'.‘_ 3. 14
& E5 VI 121 Reader Paameters | 1-2-2 Time Zone Table| 1-2-3 Holiday Table|
' 07 Ervarce bt
.:"' Lot
2 Main Oice
E'_J . Mo ¥
s & (=1e3)
-
b &38| & . LE
1 Syshesn 2 Users ] 3 Mersor | 4 Reports 5('&&:'&_ E.Schedue | 7 Help BExt |
B Bl Y =
11 12. 1.3_ i
& E5 V04 1:21 Rieades Paameters | 1:2:2 Time Zone Table| 1-2.3 Holidap Table|
() 00 Erbrance 1 Hame [
- J - Loz
102 Mar e R
Com Post
Tomanal Mo
Paameter 1 | Pasametes 2 |
ESVM\COM 01401: Entranc =
x| @) 0]

ES V3 0NCOM 02 Man Difice Sl Raader Pavamasters 1 20Pd 5/28/2008

Select System
Select Set Reader Parameters (1-2) %
The Reader Parameters tab (1-2-1) will be displayed by default.

Use this menu to add and delete readers as well as setting their basic operation parameters.
Select Add [ to display the above screen. Enter the following information :

Name : Enter a name that describes where the reader is in the building.
Location : Where is the system located. Use this field to mark remote locations.
Module : Type of reader (Leave as E5).
Com Port : Select the physical Com Port that connecting the PC to the reader.
Terminal Number : Select the number (01 to 99) that matches the terminal address that you
programmed into this reader. *

*Note: Each reader must have it's own unique terminal number

Select Save E to add the reader to the system. The new reader will appear on the left.

You can edit this reader in the future by selecting the reader from the window on the left, then
selecting Edit # . To remove a reader, select the desired reader and press Delete x| .
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SET TIME ZONE PARAMETERS

ESV3.04

@ 02 Main Office

ESV3.04\COM:01401: Entrance 1

T S
s & 5 I B € A
1.System 2 Users 3 Monitor 4 Repoits 5.Database | 6.Schedule 7.Help S Ewut
2 B G =
11 12| 13| 14

1-2-1 Reader Parameters | __1-2:2 Time Zone Table | 1-2-3 Holiday Table|

No Name | Starting [Time) From | To

1 Access Time Zone 1 0000 2400
2 Access Time Zone 2 0000 2400
3 Access Time Zone 3 0000 2400
4 Access Tme Zone 4 0000 2400
5 Access Time Zone 5 0000 2400
B Access Time Zone 6 Qpog 2400
7 Undock Time Zone 1 0000 2400
8 Urdock Time 2 0000 2400
9 Time Zon 0000 2400
10 . 0000

x| 2| o

SetReader Parameters  B853AM 5/28/2008

4

Select System |, e

Select Set Reader Parameters (1-2) Q

Select a reader from the window on the left, and press Edit m

Select the Time Zone Table tab (1-2-2)

Use this tab to edit general access and special time zone schedules:

Zone 1-6 : General time zones that set when access is allowed. Zone 1 is usually used as
a 24 hour access time zone.
Zone 7-8 : Special zones that are used to automatically unlock the door for extended

periods of time.

Zone 9 : Special zone used when CARD + PIN is required for access.
Zone 10 : Time period that the Request to Exit input on each reader is active

When you are done, select Save B/, or Cancel
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HOLIDAY SCHEDULE TABLE

EEE
= " =,
: = = L3
1Spstem | 2Users | 3Monitor | 4Repots | 5Dalsbase | BSchedde | 7Hep BExt
1 2 1 3 1 4
=T V4 0 1-2-1 Reader Parameters| 1-2-2 Time Zone Table {123 Holday Table |
No_[Name [Date -
1 Labor Day 09/07

|m|m‘w|m|m|n|w‘m

=l

~

@

=

=

~|=

&

@

~
S

w2 @[ [ [ ]
[l S el =R - S R ) el

Please note that these halidays not on a fixed date need to be programmed once every year, for example Thanksgiving Day.
>|2|o
E5V4,000COM:06\01: Reader 01 SetReader Parameters  10:21 AM 4/7/2003

Select System | *
Select Set Reader Parameters (1-2) J

Select a reader from the window on the left, and press Edit 3
Select the Holiday Table tab (1-2-3)

Double-click on the day that you wish to mark as a holiday. Once selected, the date will turn RED.

When you are done, select Save H| to exit, or Cancel ||

Note:
If you are using the automatic door unlock feature (Zone 7) and do not want the door to unlock on
Saturday, you must mark Saturday as a holiday.

P:\Installation Instructions\Access Controls\Inst-ES\INST-E5.vsd Rev C 03-13 Page: 11



UPDATE READER TIME

To synchronize all readers to the same time
and date :

Select System -
Select Time Correctlon for Reader (1-3) ﬂ

1. Set the Region (Time Zone), Date and
Time for each Com Port shown.

2. Press Start ¥/ to begin updating to the
readers. All readers that are connected to
the chosen com port will be simultaneously
updated with the same time and date.

COMMUNICATIONS LINK TEST

A, — g )|
-
b @0 H| 8 @
1.5ystem 2Users 3 Moritor mmn SDatsbase | BSchedue | 7Hep 8Ext
#
12| 13 14
Com Port_|Region |Date | Time
) MT +08:001T .
2 ;
¥
Time Conection for Reader 857 AM 5/28/2008
s, 3= [5]x)|
= -
ﬁg @ & | @ 9
1.System 2 Users 3. Monitor 4 Repoits S.Database | B.Schedule 7Help B.Ext
& Number of Test: [10000
1| Stiing of Test: |
Success: 0
Failure: 0
=
5|
Communication Test 304PM 5/27/2008

P:\Installation Instructions\Access Controls\Inst-ES\INST-E5.vsd

Rev C

Select System 13
Select Communication Test (1-4)

Select the com port(s) that you wish to test by
clicking on the port number in the left hand
window.

Enter the number of times you wish to repeat
the test (typically 10 to 1000).

Press Start 22| to begin the test.

The number of successful and failed data
packets will be displayed on the screen. To
stop the test at any time, press End & .

Multiple failures indicate a connection
problem between the PC and the readers.
Make sure that all data cable connections are
tight and that the cable is kept away from any
source of electromagnetic interference such
as florescent light fixtures or unshielded high
voltage lines.
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COMPANY PROFILE

nE = B[]

1System | 2Users | 3Monkor | 4 Reports |
=3 BH 8 | o
21| 22| 23| 24| 25| 2

b
[,
[
[
Zip Code: joes12
|
l
l
I

thp: £ Avevews. adi-dist. com

| Compary Profie Setting  902AM 5/28/2008

o

Select Users zu& [

Select Company Profile (2-1) fﬁﬂ

Select Edit # to enter company profile information. Press Save H| to exit the edit
mode, or Cancel

P

!
L
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DEPARTMENT CODE MAINTENANCE

&-ﬁ.r:_-—_“:aﬂfm‘] Se|ect Users gl
_ Select Department Setting (2-2)
:E-I Efka ﬁ % P J ( ) 22
1.5ystem 2Users 3 Morsto 4Fepots | SDatabase | ESchedus 7.Help BEat
2 09| B | Add, edit, or delete department codes
%Qﬁli ﬂl% | using this screen. Users may be
;-;;n 5'-“'5';;; it assigned to a department through the
suss ose . Cardholder Profile screen.

Select Edit # to add or change a
department code. Be sure to press Enter
on your keyboard after each new or
edited department code entry.

Select a department name and press
Delete x |to delete a department

x|

bpsment s sman s22s | Use Save H] to exit, or Cancel |

JOB TITLE MAINTENANCE

%malﬂﬂ Select Users g& [
Select Job Title Setting (2-3)

h | 30 8 & % € 9

1. Sytem 2 sz 3 Meorsdor 4 Reportz SDatshate | 6Schedus T Help BExt

B ilg® | Add, edit, or delete Job Title codes using
%,:,jﬁiﬁﬂ this screen. Users may be assigned to a
D Job Title through the Cardholder Profile
Ergime screen.
Superdic
Dwmes R
s P Select Edit # to add or change a Job

Title code. Be sure to press Enter on your
keyboard after each new or edited Job Title
code entry.

Select a Job Title name and press Delete x |
2« to delete a Job Title

Job Tie Setting TP SIZT2008

Note: Both the Job Title and Department fields are optional. If you include them in
each user’s profile you may use them in the report module to sort your user and
transaction data.
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CARDHOLDER PROFILES

Al A0

b € & &8 @ 9

1.5ystem 2 Users ‘ 3 Monitor

4 Repoits 5.Database | B Schedule 7 Help BExt

B a3 S

21 22| 23| 24| 25| 26

!EEW ID | Name | Card Mo Employee1D: | Rematk: |

1 * Chuck Robinson 00111350 q i

00 Bob Smith 00111352 A [ o =] s+ |

an Mary Jones 00111351 Card Ne [ Job Tite: [ =]
Teleghone: | Gender: | |
Mobile Phone: | | |
Address: | | _]
E-Mat | |
Ds E5V3.04

0.s

- Dt—] 01: Entrance 1
O] 02 Main Office

dlojwx|2|D

1/3 Cardholder Profile Selting 323 AM 5/28/2003

Select Users 2uﬁ

Select Cardholders Profile Setting (2-4) %

Use this menu to add and delete cardholders as well as setting their access parameters.
There are two methods for adding cardholders to the database:

Method 1 — All the cardholder information is entered manually. This is recommended for a
small number of cards. If the card number is not printed on the card, the end user can
obtain the card number by presenting it to the reader:

FUNCTION PROCEDURE DISPLAY WILL SHOW
Enter Programming Press and Hold the ‘#’ for | 0. CHECK VERSION
Mode 3 seconds 1. SETUP
Enter Check Card No. ey CARD PLEASE
Enter “3
Menu
Present the card whose Present card to reader CARD PLEASE
number you want to view ## Bits ###HIH#

The 8-digit card number appears after XX Bits’. You have approximately 30 seconds to copy
the number down and present another card, or press ‘# to exit to the main screen.

P:\Installation Instructions\Access Controls\Inst-ES\INST-E5.vsd Rev C 03-13 Page: 15



CARDHOLDER PROFILES (Continued)

To ADD a Cardholder using METHOD 1:
Select Add [ . Enter the following information :

Employee ID : Enter an employee number. Each number must be unigue.
Name : Name of Employee.
Card Number : Enter the access card or key fob number.
Access TZ : Select the time zone that this user will be active.
Password : If PIN codes are used with each card, enter that PIN here

Select the card reader(s) assigned to the user by checking the box next to the reader.

All other information is optional, but you may use them in the report module to sort your
user and transaction data.

Press Save H | to complete adding the user to the database, or press Cancel | ™ | .

To EDIT an existing Cardholder:

You can edit a user in the future by selecting the user from the window on the left, then
selecting Edit @ . When you are done editing select Save H |, orCancel |

Method 2 — Using the Import Cardholder Data button , cards are easily added at a
card reader. The card numbers can then be downloaded to a Microsoft® Excel spreadsheet,
where user profile information can be added. The last step is to upload the spreadsheet to
the software database. Fields in Blue (Holiday, AccessTZ, & PassWord) must still be
entered manually. This method is recommended for a large number of cards (50+ users).
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CARDHOLDER PROFILES (Continued)

To add a Cardholder using METHOD 2:

Step 1 — Enroll the cards into the card reader. If you have multiple readers, you may choose
any reader whose communications link has been verified:

FUNCTION PROCEDURE DISPLAY WILL SHOW
Enter Programming Press and Hold the ‘#’ for | 0. CHECK VERSION
Mode 3 seconds 1. SETUP
Enter Setup Enter “1” PASSWORD:
Enter Password Enter “1111” +*“#” 1.ENROL 2. PASSWD

3. TIMER 4. SYSTEM
1. ACCESS CARD

Select Enroll Menu Enter “1 2. PATROL CARD
s AMOUNT: #
Select Access Card Menu | Enter “1 CARD NO.:

The card number will appear on the screen as you present each card, and the AMOUNT field
will increment by one after each card. When all the cards have been enrolled, press ‘# to
return to the main screen.

Step 2 — Import the cards from the Reader into the reference Excel file.
Go to Start > All Programs > SDC > E5 > UploadAcsCard

M e A e Ty @l  Select the Com Port & Terminal Address Number for
[emen [ = the Reader with the cards enrolled. Do not change
Teminal No: [1 ~] Baud Rate or Data Format.

Baud Rate: | 9600 |

Data Fomat: [0.7.1 = Select the location and file name where the card

Save File &s: [C:\Program Files\SDC\ES\20080528. s =] information will be saved. The default file name is
today’s date.

Exit

Press Upload. You will see the programming
running. After the upload is complete, press Exit.

Step 3 — Import the reference Excel file into the database.

= SmportiGardholderiData J | J»th

| Import Events | Employee ID CardNo ‘Name | Department | Job Title

‘ Select Users g
Select Cardholders Profile Setting (2-4) %
Select Import Cardholder Data o
Press the Open A Reference File link on the lower left.
The link opens ImportE.xls (see next page).

[sheen a I [=| | o

P:\Installation Instructions\Access Controls\INST-E5.vsd Rev C 03-13 Page:17



Reference the file spreadsheet notes for a brief description of each column. Red column headers

CARDHOLDER PROFILES (Continued)

indicate required fields.

B3 Microsoft Excel - ImportE.xls
/‘ —:-i}ﬁlE Edit View Insert Format TJools Data Window Help
() BYET: TYERNE A AR RN AR o Y1) W
Al - & Euvents
A D |
T —WPCvelis
(a) 2 Customer Service Birector
| 3 | Customer Service Engineer
4 Sales Engineer
| 5 |
61 (c) 333 Tekt Card
| 7
3 Software R&D
| 9 |
10
11|
12
i A Thecodeswillbe 0. 1.2, 3 5
14 0:No ot Tt ,-'.-t. - I not 1. The emplayee ID number 1. The card number can 1. You may leave the 1. You may leave the
? - cr:twlal:gde.t LRl can NOT be duplicated NOT be duplicated. Department Field Job Title Field blank
— Dr_IC_HEeT :“ dada. I 2. The employee ID number 2. The card number blank 2. Please make sure
716 S TOrCe SO o e e Field can NOT be blank and Field can NOT be blank 2. Please make sure the Job Title iz correct.
17 will enforce adding data. and will - et iacost
e A R the employee ID No. can and the card number the name of e sysf e.m J\TI accep
18 i & MOT be duplicated neither, can NOT be duplicated department is correct. any new job title if it has
19 ;U s s The sk vl otherwize the system will neither, ctherwise the The system will accept] |not existed yet. For
== u aafe i cf:lf; s MOT process this data. aystem will NOT process any new department if example you are going
ﬂ : pﬂ IH ) gll; B this data. it has not existed yet. to add Salesman as a
21 ; ;Z e:11F:f:|fae Tu.m Tlr:‘m b 3. lf the digite of the card For example you are new job title, but you
22 | ara Ia_ecli. wftm; c_::‘ee - r:um‘ e”r number fewer than geing to add a new mistakenly enter Man
1asa fea paiias il dT =mw default, the system will employee 1D Me. of on Sale. The system
23 add this data intc database if the - . . a
e ST L. automatically add O the Marketing will create Man on Sale
724 5;111p G llabrtbi Lo ALt prior to the card Department, but you as a new job title
25 : number. For example mistakenly enter the
S 3 aystermn wi : d i
26 4 _I.I::e\eltlaﬂdat: tTheI __:’_tdelmﬂmll the card number of 333 Fish Market
eele il Col o aetioiS will become 00000333 Department, the
27 employee ID number. 2
E in database system will not only
= dd i w D N
29 B. The imported event Field can NOT 5 e, °
T but alsc will
30 b automatically create
31 the Fish Market
32 Department
33 3
4 4 » nlySheetl/ |< B
Ready NUM

(a) Click on the Red “Events” in cell A1.

(b) Press Ctrl+A to highlight the sample data.
(c) Go to Edit > Delete. Press OK to confirm.
(

(

(®)
~— N e

d) Go to Data > Import External Data > Import Data

e) Select the data source. This will be the *.xIs file created in Step 2. Once the file has been
selected, Press Open, then OK, and OK to confirm.

(f) Once the data has been generated, Press File > Save As...,
than ImportE.xIs

and choose a file name other

The data generated will look similar to the table above. The Events & CardNo columns will
already be completed. Complete the remaining required fields (Employee ID & Name), and the
Department & JobTitle, if necessary. Save & Close the file.

Return to the Import Cardholder Data window in Step 2.
Select File|.2] in the lower right corner.

Select the file created in (f) above, and press Open.
Once the data is imported, press Save EJ and Exit | ™.
Return to Cardholders Profile Setting (2-4), and follow the instructions for editing an existing
Cardholder (Page 9) to continue editing the users.
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31‘}.'3 @

1.5ystem 2Users

al

3 Monitor

B 8

4Reports | 5Database

PROGRAM ACCESS — ACCOUNT AND PIN SETTINGS

| @

6.Schedule 7Help

AEE|

9 |

8Em

22 23 24 25|ZS

Account | Name E - E5V3i.n4
!ﬁ, i = B 1.System System

em Parameters
Bk 1-2 SetReader Parameters
B8t 3 TlmE Correction for Reader

E® 1-4 Communication Test

Bl 2 Users |
BE 2 Cn m]mvprm ile Setting

EJ 2-2 Department Setting

B 2-3 Job Title Setting

B8 2-4 Cardholder Profile Setting

B = 2-5 Account & PIN setlings

2% 2-6 Download Parameters
EAED 3Monitor Monitor

B 31 Collect Transactions in Batch

E® 3-2 Real Time Monitoring
BzP 33 Remotely Open Door
E],_J 34 Resmre Trensaclions
B 4R Re
E_’| 4-1 Tmnsacnormepous
B&) 42 Export Settings
(S _} 43 Sum are Access Record
@ 5 Databs
Baxd 5 -1 Louy F«eadcr Data
% 5-2 Copy Cardholder Profile
EF 5-3 Backup Database
E]fj, 5-4 Restore Database
B 55 Zip Datebase (Repair)
B 56 Scheduled Jobs

Accourt & PIN sattings

2|0l

953AM 5/28/2008

Select Users 2uﬁ

Select Account & Pin Settings (2-5) J

Access to the program and its settings are set
from this screen. The default administrator
user account name is “a” with a password of
“a”. This account is configured to have

complete access to all areas of the program.

Select Add 0O or Edit # to add or edit
authorized users, change program access
passwords or limit areas of program access.
Select Save H|or Cancel when you are
done.

Select an Account Name and press Delete x |
to delete an account. Note: The default
administrator cannot be deleted.

DOWNLOAD DATA TO READERS

A _ud'%
b @ I <@ |
1.5ystem 2Users mwm 4Repots | 5Database ssm 7Help azu
Ia'J d|=| @ o)

22| 23| 24| 25|28

(B £5va.04 I | Download Paameters of Reader I

|= B35 I | Download Pasameters of Holday Table |

| “Ul Entrance 1 ; 5 |

Y I~ Dowrload Parameters of Time Zone Table ‘

| A 02 Main Difice [~ Dowrload Parameters of Access Card I

|

|

|

|

|

B/ |
Download Parameters 955AM 5/28/2008
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Select Users w@
Select Download Parameters (2-6) ‘fi

Readers are updated with new data using this
screen. You can choose to download all or
selected parts of the database.

Select the check box of the reader(s) to be
updated from the window on the left. Check
the parameters that are to be downloaded
and press Start. |

The progress of the download will be shown
on the screen.
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SYSTEM MONITORING (AUDIT TRAIL)

Each reader stores every transaction for future uploading to the PC. This data may be retrieved
in a batch or in a real-time manner. Real-time transaction monitoring requires that this program

run at all times.

Batch Collection

AlE A=8
e | e
h (0 8 & % €9
1Sysem | 2Users | 3Montos | AFepoits | SDochase | GSchede |  THeb aEw |
SEIEIE
21 32| 33| 34
B esvam " [Tam Reudes Everts Rend
= [
B 0 Ertrance 1
= e
B 02 Man Otz
24
Collect Trareactions in Baich 1006 AM 5/28/2008
Real Time Monitoring
:_‘153 J..]rﬂ
B | B | B2 | =8,
1.System 2Usens IMonkor | 4Repots | SDatabate | 65chedde 7 Help 8Ex ADI
@ SJ of | &
e g e R e
Di_ggm Resder | Emplopee D | Nome Evert | Dat Time
) 01: Enance 1
os
5) 02 Main Office
Resder | EmployeeD | Name Events Date Time |
| ACS30351
= &
| @] =

&
3. Manitor

Select Monitor
Select Collect Transactions in Batch (3-1)

Select the reader(s) from the window on the
left, then select Start # . The number of
transactions collected will appear in the
window to the right.

@
3.Marikor

Select Monitor &
Select Real Time Monitoring (3-2) -

Select the reader(s) from the window on the

left, then select Start & |. Transactions will

appear in the window to the right. The reader
polling interval may be changed by adjusting
the slider at the bottom of the screen. Select
Break %] to stop the polling.

—‘ Impading data, pleste wal

Real Time Montoring Break.  10:12AM 5/28/2008

Rev C
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REMOTELY LOCKING / UNLOCKING THE DOOR

-

EIEx)

b €| 3| S % € 4

_iSyden | 2Usen | Mo | afieots | SOwsbws | Sscwesss | 1 8t || Gglect Monitor

,3" ﬁ_@u _ _ _ Select Remotely Open Door (3-3) ﬂ
& ES Vi | Tume Floader | Evenits Fesit
[eecn [T [T :
8¢ Eﬂ You may remotely lock or unlock each door by
T using this screen. Check the box next to the
reader you wish to control and select:
Unlock |,
Emergency Unlock = (reader will beep), or
Emergency Lock s .
#|8) 5

Reamtely Opon Do 10Z9AM S282008

RESTORE TRANSACTION DATA

AL . , _ 58 goiect Monitor
h ¢ D ®H 8 % € A Select Restore Transactions (3-4) |2
Spom | 2Usms | AMorwe | 4Fepors | SOusbwe | Gschedie | Thdp | atw |
__31 EQL . - _ When you retrieve a transaction, the
e } —— record of that transaction is uploaded to
as 2” the PC and deleted from the reader. You

may place the transaction data back into
the reader by using the restore data
function. B

Select the reader(s) from the window on
the left, then select Start . The
collected transactions be downloaded

| back into the reader(s).

Restore Transachons 103 AN 55282008
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TRANSACTION REPORTS

A AED Select Reports 4
5 [ = ) _ - Select Transactlon Reports (4-1) 41
1!-.,“,. g | J‘SJ , ;g saé.r sfi‘ Q | ;’i | The Find window will appear.
= A
T L T T e o L T R To create a report of all transactions,
select the dates you would like to search,
leave all other fields blank, then select
Search |, or Cancel [~ |. If you
[T & cancel, select Find < |to access the
- = Find window.
e To create a filtered report, enter the data
g Gore e you wish to search for, then select
f— = Search a.
T ke | Once the report is displayed on the
o« | screen, it may be reviewed on screen or
printed by selecting Print ﬂ
REPORT EXPORT
(15 - 5] Select Reports 4t
m 44} = J * 8 2 @ 9 Select Export Settings (4-2)
| LSmem | 2Usn | IMootor | dBapots | SDstabase | ESchedds | 7Heb | 8Em |
| 3 %J Use this screen to create a text file to
:mm _ _ — , export to outside programs.
| Date From |5 7282008 =] Te 5 /28/2008 =l &
[ Select Edit
| L*”::‘:;” — 5 i Select the fields and data to export.
| aetr i ot [ Note: The Special String field will
| Cokm2 [Spec St <0 [ B separate the columns.
| Columniza [Accass Dare = | yerendd | [ =
| m:z?s” z ! ;—J| Select Path S to change the file name
| coumnts [Specasoms =] | =] and data path that you wish the file to be
[ ] ={tbmn -] I ] saved to.
| Cokmn8 [Special Sting B [ =]
| Cokeetn [Tomeaitie =] = —
| cohmnt0 [Specisomg =] [ =] Select Save H|, or Cancel |
Select the date range for the data to be
3 exported.
Evpint Setmgs 02 AM S/20/2008
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Now select Start & .
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SOFTWARE ACCESS RECORD

Select Reports

B
4 Reports

Select Software Access Record (4-3) ﬁ

Every action that is made while in this
program is recorded in an internal audit trail
log. Use this screen to access this log.

i

AR

32

@ A

[*]

1.5ystem 2Upers 4Repordz | 5Databace 7.Help 8Ext
JE
) ez a3
No | Accourt | FunctionNo. | Funciion Name | Date [Remak_ B3|
1 a 5] Selware Access Alecond S/26/2008 11:08:38 AM
2 a &2 Expert Settrgs S/2652008 11:0218 &M
3 s 41 Tranaaction Fleports S/26/2008 1014217 AM
4 s 4 Restose Tisnsachons Sr282008 100013 AM
5 a 33 FAlemotely Dpen Doot SF2072008 1003054 &AM
6 a 4 RAeslcen Transachon: S/2852008 1003053 AM
7 s 33 FRemotely Dpen Docs S/28/2008 10:30:52 AM
8 s 34 Restoes Transachons S/26/2008 10.30:49 &M
k] a kx| RAemotely Dpen Dooe 52072000 10 2500 &M
10 s 32 Flesl Tane Moritcrng S/26/2008 10.10:35 AM
n s 32 Feal Time Monitoeng S5/26/2008 10.10:33 AM
12 a 32 Fleal Time Moritoeing S/28/2008 101013 AM
13 a k2| Collect Traraactions n Batch S/28/2008 1000535 AM
14 a 6 Diownioad Pacameters S/ZR/H008 %5522 AM
15 & 25 Account & FIN settings S/28/2008 35232 AM
16 a 24 Candholdes Profis Seftng S/2852008 5 2822 AM
17 s 25 Account § FIN sefting: 5/26/2008 3:28:21 AM
18 2 Fa Diowriaad Parametess S/2R/2008 3 20 21 AM
19 a 25 Account & FIN etting: 5/28/2008 & 2818 AM
n s 24 Cardholder Profle Sefting S/20/2000 3 21:02 AM
F4 | a 25 Account & FIN seltngs S/2R/2008 S 21:01 AM
= a 26 Digwrdnd Parareter: S/26/2008 9 20.59 AM
el a 24 Candhioddes Profle Setting S/28/2008 31324 AM
u a 23 Job Tithe Settng S/26/2008 311:33AM
F--1 s 22 Depatment Settrg S/26/2008 90507 AM
% a 21 Company Profie Sening /2072008 8:5513 AM
0 a 14 Coreerurec shon Test S/26/2008 8 59.09.AM
2 a 13 Time Coenaction hor Reader S/28/2008 & 5607 AM
] ] 12 Set Reader Parameters S/28/2008 852 03AM
3 a 13 Tirms Comrection hor Reader S/28/2008 & 5204 AM
n s 12 St Rleader Paiameter /26,2008 8 ¥5:09 AM
x a i1 Set Spatem Parsmeters S/20/2008 & 3502 AM
n a Peswiet Lzee Log iIn SSERF000 8 3042 AM
H a Powoss Llzer Lo out SA2TS2008 350:54 FW a
x s 4 Candholder Profie Seftng 5/27/2008 3 ¥5:56 PM
* a 22 Depaitmert Settrg S/27/2008 3 34:03 PM
n & 26 Diowerboad Parametens S/2T2008 3 34:02 PM
k=) a 22 Depatmert Settirg SF2T72008 33348 FM
£ s 23 Job Tithe Seltng S/27/2008 32319 PM
40 a 22 Department Settrg S/27/2008 3 25:40 PM
an a 12 St Reade Parameten: SA27,0008 31543 PM (v

Sofware AccessRecord  [11:09AM 5/28/2008 o’
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Select Database ssa

Select Copy Reader Data (5-1)

Use this screen to copy system configuration
and scheduling data from one reader to
another. Note: A minimum of two readers
must be configured in the Reader Parameters
(1-1-2).

To Copy:

1. Select a source reader in the Copying
From box and then check the appropriate
boxes below to select the type of data to copy.

2. Select the reader in the window to the right
that you wish to copy the configuration data to.

3. Press SaveE, and press Yes to confirm, or
No to cancel.

CARDHOLDER PROFILES

[ o]x]|

| Mo
Dk Robaon

o Bok St

| Department
PROD
SALES

Job Thle
WP Dipeeishons
Maruage

| Cad Mar
XD
e

Copy Cardholider Profie

=)
T:204M 577872008 |

Rev C

Select Database 533

Select Copy Cardholder Profile (5-2)

Use this screen to copy cardholder
configuration data from one cardholder
profile to another.

To Copy:

1. Select a source card in the Copying
From box and select the items that you
wish to copy.

2. Select the cardholder(s) in the window
to the right that you wish to copy the
data to.

3. Press Save EJ and Select Yes to
confirm, or No to cancel.
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My Computer
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BACKUP DATABASE

(= [B]X]

<@

& ct 8-

e

7]}

Cancel |
J

125

%

aaEs e
51 s2)[s3f 54 5] s

)

5 Databaie

&

2Usen

L
& Schedue |

&

Rieports

u!

3 Morion

ackup Databise

Save v | < Local Disk [T) -J

L - L WINDOWS
~.-.:) g Cocuments and Settings | WiiTemp
by Recert epsan
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= pritdry
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It is important that you backup your
database every time that you make a
configuration change or add/delete a user.
Select Database Sm

Select Backup Database (5-3)

To Backup:

1. Enter a file name and location to create
a backup database file (the default file
name is the date).

2. Press Save ,or Cancel s |

A message will appear confirming that the
backup file has been created.

RESTORE DATABASE

4 =8|

q |

@

THeb

8Ea |

? X

- @ ¢ E-
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Select Database sse
Select Restore Database (5-4)

To Restore:
1. Enter a file name and location of
the database backup file .

2. Press the Save [ s | or
Cancel _ G2 | |

Your configuration, scheduling and
cardholder data will now be
restored.
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DATABASE REPAIR

a5 a=8
e | 0 85 8 % € 9
15ysbem | 2Uoees |  JMondor | 4dRepots  SOstsbase | GSchedde |  THep = 8Em |
PN G E] s
iﬁiﬁ!i Select Database 53& .
Select Zip Database (Repair) (5-5)
If your database becomes corrupt and
you do not have a current backup file,
| AGS3035, = you may be able to save you data by
L e ok running this utility.
=1 When select the option button, the utility
will automatically run. Since this is not a
guarantee of data recovery, you will need
to check your data for accuracy.
SCHEDULED JOBS
Select Database sw
Select Scheduled Jobs (5-6)
Ay S B[] , ,
' S y This screen configures the tasks that the
LA A AR AR Schedule Module (Menu 6.) will perform.

To enable a task:

b et cocies ckad

L3F Symchionization fo times fom ths syt i neader Dz bl Nt

JESCusbeotiuck 0 Ot Nerw 1. Select a task in the window then

&M Sunchroraong bor pasamaeters om the syttem i meades Driz bl Mever

[ | T s select Edit (# .

[10

2. Select the Enabled box to the right to
activate the task. You can now change
the various time settings within that
scheduled task.

2 3.Toexit, select Save B/, or Cancel [=

Raineve stoest iecond Scheduled Jobs 1241 PM 572802008

4. Repeat these steps to activate any
other task(s).
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AUTOMATIC MONITORING (SCHEDULING)

44

2Users

8

4 Fteootls 5.Database

3 Monitor 5 Schedule |

= 0]

7.Help 8Est

Qsa S(QE

| Erlioponti

- —_—
Account ”

% Pass word I

Log out ‘ Exit

Zip Database (Repaw) 1251 PM 5/28/2008

ESAnt
Run

-
&

i}

fomaticschednling,

o= 8

C[EX)|

TE
= =i
iy

9 cou

Time | Reader

| Events

| Result

[HAfe] 07: Entrance 1

A1) 02: Main Office

1.02PM 5/28/2008

File Run

LB Antomaticschediling

56

- B[]

2
-IZI?
2
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Time | Reader

J Events

\ Result

.[_] 07: Entrance 1

.[] 02: Main Office

Account:

[a—
% Pass word: H

Login } Enxit l ‘

1:02PM 5/28/2008

Rev C

Select Schedule |:simie

Use your account and password to exit
the main program and enter the
scheduling module.

Select the Start _#| button to enable the
scheduling and monitoring module. The
module will run in the background on
your PC and perform the polling and
updating functions for the readers that
are checked in the left window. The tasks
will be performed per the schedules that
were enabled in the task list (Database —
Scheduled Jobs (5-6)).

Double click on the icon in your windows
toolbar to re-enter this module. To pause
the module select the Break & button.
To return to the main program select the
Return to Main @ button. To stop the
module and exit the program select the
Exit @| button.
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